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Software License Agreement 
Carefully read the following terms and conditions sign and return as accepting 
these terms and conditions. 

This is a legal agreement between you, the end user (either an individual or an 
entity), and Scanvec Amiable, Inc.  If you do not agree with the following, you 
should promptly return the package. Use of this program indicates your 
acceptance of the terms and conditions stated below. 

The enclosed computer program "Software" is licensed, not sold, to you by 
Scanvec Amiable, Inc., for use on a non-exclusive, non-transferable basis, only 
under the following terms, and Scanvec Amiable, Inc., reserves any rights not 
expressly granted to you.  You may not disclose to any third party any 
confidential information concerning the Software or Scanvec Amiable, Inc. or use 
such confidential information to the detriment of Scanvec Amiable, Inc... 

1. License. 

This software is protected by the United States Copyright Law and International 
Treaty Provisions. Therefore, you must treat the Software just as you would any 
other copyrighted material, such as a book. This license allows you to: 

(a) Make one copy of the Software in machine readable form; provided 
that such a copy of the original may be used solely for backup purposes. 
As an express condition of this License, you must reproduce on each copy 
of the Scanvec Amiable, Inc., copyright notice and any other proprietary 
legends on the original copy supplied by Scanvec Amiable, Inc. 

(b) Transfer the Software and all rights under this License to another party 
together with a copy of this License and all written materials 
accompanying the Software provided you give Scanvec Amiable, Inc., 
written notice of the transfer and the other party reads and agrees to 
accept the terms and conditions of this License. 

(c) Use this Software on a single computer only, but may transfer it to 
another computer as long as it is used on only one computer at a time. “In 
Use” constitutes being loaded onto either temporary (i.e., RAM) or 
permanent memory (e.g., hard disk, CD-ROM or other storage device) of a 
computer. 

2. Restrictions. 

You may NOT distribute copies of the Software to others or electronically transfer 
the Software from one computer to another over a network. You may not de-
compile, reverse engineer, disassemble or otherwise reduce the Software to a 
human perceivable form. You may not modify, adapt, transfer, rent, lease, loan, 
resell for profit, distribute, network or create derivative works based upon the 
software or any part thereof. 

3. Termination. 

This License is effective until terminated. This License will terminate immediately 
if you fail to comply with any of its provisions. Upon termination, you must return 
the Software, and all copies thereof, to Scanvec Amiable, Inc., and you may 
terminate this License at any time by doing so. 

4. Export Law Assurances.  

You agree that neither the Software nor any direct product thereof will be 
transferred or exported, directly or indirectly, into any country prohibited by the 
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United States Export Administration Act or any international export laws and the 
restrictions and regulations thereunder, nor will it be used for any purposes 
prohibited by the Act or laws. 

5. Warranty Disclaimer, Limitation of Remedies and Damages. 

In no event will Scanvec Amiable, Inc., be liable for any damages, including 
infringement, lost data, lost profits, cost of cover or other special, incidental, 
consequential or indirect damages arising from the use of the program however 
caused and on any theory of liability. This limitation will apply even if Scanvec 
Amiable, Inc., or an authorized dealer or distributor has been advised of the 
possibility of such damage.  SCANVEC AMIABLE, Inc. MAKES NO 
WARRANTY, EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE, 
AND DISCLAIMS, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF 
MERCHANTIBILITY OR FITNESS FOR A PARTICULAR PURPOSE.  Scanvec 
Amiable, Inc., does not warrant any drivers for plotting, scanning or either 
devices. These drivers are provided for our customers as a service only, and 
were developed using information provided to us at the time by the equipment 
manufacturers.  

Scanvec Amiable, Inc., is not responsible for any typographical errors in the 
software or in the documentation. 

6. General. 

If you are a U.S. Government end-user, this License of the Software conveys 
only "RESTRICTED RIGHTS," and its use, disclosure, and duplication are 
subject to Federal Acquisition Regulations, 52.227-7013(c)(1)(ii). This License 
will be construed under the laws of the State of Pennsylvania, except for that 
body of law dealing with conflicts of law, if obtained in the U.S., or the laws of 
jurisdiction where obtained, if obtained outside the U.S. If any provision of this 
License is held by a court of competent jurisdiction to be contrary to law, that 
provision of this License will remain in full force and effect. 

© Copyright 2006 by Scanvec Amiable, Inc. All rights reserved. No part of this 
publication may be reproduced, stored in a retrieval system or transmitted, in any 
form or by any means, electronic, mechanical, photocopy, recording or 
otherwise, without the prior written permission of the publisher. Printed in the 
United States of America.  The information in this manual is subject to change 
without notice and does not represent a commitment on the part of Scanvec 
Amiable, Inc. 

Acrobat® Reader Copyright© 1987-2002 Adobe Systems Incorporated. All rights 
reserved. Adobe and Acrobat are trademarks of Adobe Systems Incorporated 
which may be registered in certain jurisdictions. PostScript®  software 
Copyright© 1984-1998 Adobe Systems Incorporated. All rights reserved. 

Flexi, FlexiFAMILY, FlexiSIGN-Pro, FlexiSIGN Plus, FlexiEXPERT, FlexiSIGN, 
FlexiLETTER, FlexiDESIGNER, FlexiCUT, FlexiENGRAVE, PhotoPRINT Server, 
PhotoPRINT, PhotoPRINT SE, EnRoute-Pro, EnRoute Plus, EnRoute, EnRoute-
Machine Shop, and/or other Scanvec Amiable products referenced herein are 
either trademarks or registered trademarks of Scanvec Amiable, Inc. Illustrator is 
a registered trademark of Adobe Systems Incorporated. FreeHand is a registered 
trademark of Macromedia Corporation. CorelDRAW! is a trademark of Corel 
Systems Corporation. AppleTalk, ImageWriter, LaserWriter, and Macintosh are 
registered trademarks of Apple Computer, Inc. Windows is a registered 
trademark of Microsoft Corporation. The names of actual companies and 
products mentioned herein may be the trademarks and/or registered trademarks 
of their respective owners. Adobe® is a trademark of Adobe Systems 
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Incorporated or its subsidiaries and may be registered in certain jurisdictions.  
PostScript® is a trademark of Adobe Systems Incorporated or its subsidiaries 
and may be registered in certain jurisdictions. 

Scanvec Amiable, Inc. 
International Plaza Two, Suite 625 
Philadelphia, PA  19113-1518 
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1. Working with Laser Engravers 
Overview 
A laser engraving tool uses a laser to engrave a design into an object by 
scanning across the surface of the object and vaporizing the material in 
its path. 

 

Engraving Raster vs. Vector Graphics 
Vector graphics define a picture as a set of mathematical points, lines, 
curves and shapes. Raster graphics define a picture as an array of dots 
called pixels. 

Laser engravers treat vector graphics and raster images differently.  

Engraving Raster Images 
When cutting out a raster image, the laser engraver will make a series 
of horizontal cuts that engrave out the entire area covered by the image. 
Areas with different colors will be engraved to different depths. 

   
Engraving Vector Graphics 
Vector graphics are translated into a set of cutting paths that the laser 
will follow when engraving the design. Filled objects are rendered using 
the same technique as a raster image: a set of closely spaced 
horizontal cuts that carve out the entire area. 
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Laser Engraver Setup 
There are three steps to setting up the software to work with a laser 
engraver: 

1. Installing a driver for the laser engraver. 

2. Setting the cutting power and speed associated with pen colors. 

3. Creating a custom swatch table for the laser engraver. 

Installing a Driver for the Laser Engraver 
The driver for the laser engraver functions like a local printer driver. 

To install the driver: 

1. From the Windows Start menu, select Settings then Printers. 

2. In the Printers window, click Add Printer. 

3. In the Add Printer Wizard, click Next. 

4. Select Local Printer and click Next. 

5. Select your parallel port (usually LPT1) as the printer port and click 
Next. 

6. Click Have Disk and select the appropriate driver from the Drivers 
directory on your Installation CD. 

7. Select your laser engraver in the Printers list and click Next. 

8. Under Do you want your Windows-based programs to use this 
printer as the default printer? select No and click Next. 

9. Select Do not share this printer and click Next. 

10. Under Do you want to print a test page? select No and click 
Next. 

11. Click Finish. 

Setting the Cutting Power and Speed for Pen Colors 
Most laser engravers support an engraving mode in which the amount 
of power supplied to the laser and the speed at which the laser moves 
are determined by the pen color assigned to the path or pixel. 

The power and speed settings for each color can be adjusted in the 
print options for the laser engraver. The colors in your design must 
exactly match the colors recognized by the driver. 

Each type of substrate will require a different combination of speed and 
power in order to make the most efficient cut. A slower-moving laser will 
make a deeper cut than a faster-moving laser, because it spends a 
longer amount of time at each point along the path. Increasing the laser 
power will also increase the cutting power.  
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With most substrate materials, there is an upper limit to how much you 
can cut with a single pass of the laser at a given speed. This is because 
the excess heat builds up in the area around the cut until it melts or 
deforms the substrate. The solution is to cut the design using multiple 
passes of the laser. 

Each model of engraver will require unique settings for a given type of 
substrate because of differences in cutting speed and laser power. 

Manufacturer Color R G B 

Epilog Up to 16 customized RGB colors 

      Black 0 0 0 

 Red 255 0 0 

 Green 0 255 0 

 Yellow 255 255 0 

 Blue 0 0 255 

 Magenta 255 0 255 

 Cyan 0 255 255 

 Light Red 255 128 128 

 Light Green 128 255 128 

 Light Yellow 255 255 128 

 Light Blue 128 128 255 

 Light Magenta 255 128 255 

 Light Cyan 128 255 255 

 Gray 128 128 128 

 Teal 0 128 128 

GCC 

 Olive 128 128 0 

 Black 0 0 0 

 Red 255 0 0 

 Blue 0 0 255 

 Steel Blue 51 102 153 

 Light Blue 0 255 255 

 Light Green 0 255 0 

 Green 0 153 51 

 Dark Green 0 102 51 

 Tan 153 153 51 

Trotec 

 Light Brown 153 102 51 



Page 4 Working with Laser Engravers 

 Dark Brown 102 51 0 

 Dark Purple 102 0 102 

 Light Purple 153 0 204 

 Magenta 255 0 255 

 Orange 255 102 0 

 Yellow 255 255 0 

      Black 0 0 0 

 Red 255 0 0 

 Green 0 255 0 

 Yellow 255 255 0 

 Blue 0 0 255 

 Magenta 255 0 255 

 Cyan 0 255 255 

Universal 
Laser  

 Orange 255 128 0 
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      Black 0 0 0 

 Red 255 0 0 

 Navy 0 0 128 

 Magenta 255 0 255 

 Maroon 128 48 96 

 Lime 0 255 0 

 Olive 128 128 0 

 Aqua 0 255 255 

 Gray 190 190 190 

 Blue 0 0 255 

 Purple 160 32 240 

 Silver 192 192 192 

 Green 0 128 0 

 Yellow 255 255 0 

 Teal 0 128 128 

Xenetech 

 White 255 255 255 
 

Creating a Custom Swatch Table for the Laser Engraver 
In order to make sure that the colors in your design match the pen 
colors exactly, you should create a custom swatch table that contains 
the pen colors specified by the manufacturer. You can then use this 
table and be certain that the colors you assign to objects and bitmaps 
will map to the pen settings used by the engraver. 

 Uncheck Use Color Management to prevent using settings from the color 
management system.  

See “Working with Color” in the Flexi User Manual for details. 
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Designing for Laser Engraving 
The following are design tips that save time and effort when creating a 
design to be engraved with a laser engraver. 

Sizing Page to Match Work Area Dimensions 
Before you begin creating your design, set your drawing area size to the 
dimensions of the laser engraver’s work area. This ensures that the 
engraver will be able to cut your design without shrinking it, and 
eliminates any need to convert between scales when comparing the 
design and the final engraving. 

To set the drawing area size: 

1. From the File menu, select Document Setup. 

2. In DesignCentral, enter new height ( ) and width ( ) values for 
the drawing area (see below). 

 The drawing area is resized automatically to match the values entered in 
DesignCentral. 

Make/Model Width & Height (mm) Width & Height (in) 

Epilog Mini 457 x 305 18 x 12 

Epilog Legend 24TT 610 x 305 24 x 12 

Epilog Legend 24EX 610 X 508 24 x 20 

Epilog Legend 32EX 813 x 508 32 x 20 

GCC Venus 300 x 210 11.81 x 8.27 

GCC Neptune 1280 x 930 50.39 x 36.61 

GCC Jupiter 300 x 210 11.81 x 8.27 

GCC Mercury 635 x 457 25 x 18 

Xenetech XLE 1325 330.2 x 635 13 x 25 

Xenetech XLT 1325 330.2 x 635 13 x 25 

Xenetech Aurora  457.2 x 762 18 x 30 

Xenetech XLE 2436 609 x 914 24 x 36 

Xenetech XLT 2436 609 x 914 24 x 36 

ULS VersaLaser VL-200 406 x 305 16 x 12 

ULS VersaLaser VL-300 609 x 305 24 x 12 
 

Set the Origin to Match Your Engraver 
You should set the location of the origin in your software to match the 
location of the origin on the laser engraver. If the origin is in the upper 
left corner of the work area on your engraver, set the origin in the 
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software to the upper left corner also. 

     
To set the location of the origin: 

1. From the View menu select Ruler and Grid. 

2. On the Ruler tab, under Orientation, press the  button to set the 
origin to be in the top left corner. 

3. Click OK. 

Positioning the Design 
The substrate must be positioned exactly as defined in the design. The 
laser engraver cannot detect the location of the substrate: it can only cut 
where it is told. 

For this reason, it’s best to set up your design so that the substrate sits 
in a corner of the cutting table. This eliminates any need to measure out 
the position. 

   

Marking the Boundaries of the Substrate with a Guide 
It is often difficult to determine exactly where the boundaries of the 
substrate are when you are working on your design. It makes it easier if 
you add an object to your design that has the same size, shape and 
location as the substrate, then make the object into a guide. 

To make an object into a guide: 

1. Select the object. 

2. From the Arrange menu, select Guides then Make Guide. 

The guide object will appear as a dotted blue outline. 
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Fill and Stroke Settings 
When a vector object is rendered into laser engraving paths, the fill and 
stroke settings of the object are handled as follows: 

• The fill of the object, if any, is engraved out like a raster fill. 

   

• The stroke of the object, if any, is handled in one of two ways: 

 If the width of the stroke is 0 or 0.001, the stroke will be cut as 
a vector outline. 

   
 If the stroke is wider than 0.001, it will be cut as a raster image. 

   
Wireframe 
If you want to turn a vector object with a fill into a single engraving path 
that follows the outline of the object, check the Wireframe option in the 
Fill/Stroke Editor. 
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The fill color of the wireframe object will determine the cutting speed 
and power used to engrave it. 

     

Font Handling 
Standard Fonts 
When text using TrueType or Adobe Type 1 fonts is engraved, it is 
treated as an object with a fill and rasterized. 

   
Engraving Fonts 
When text using an engraving font is engraved, it is treated like an 
outline. 

   
The engraving fonts included with the software are: 

 Avanti 1 
 

 Baha 1 
 

 Cent 3 
 

 College 2 
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 Engrave 1 
 

 Helvet 1 
 

 Huckle 1 
 

 Script 1 

 

 Serif 1 
 

 Wedding 3 

 
 



Working with Laser Engravers Page 11 

Sending Output to the Laser Engraver 
When you output a design to the laser engraver, you will print it like you 
were printing to a desktop printer, selecting the laser engraver driver. 

To output a design to the laser engraver: 

1. Position the substrate in the engraver so that it occupies the 
position specified in your design. 

2. Close the engraver cover. 

3. Adjust the focus of your laser. 

4. From the File menu, select Print. 

5. In the Print dialog, select the laser engraver driver from the list of 
available print drivers. 

6. Click the Options button in the Print dialog. 

 
7. Set the following options: 

Scale Select Fit border to paper. 

Tiling Clear the Print tiled pages checkbox. 

Options Clear the Print border checkbox. 
Check Use Device Margins. 

 
8. Click OK to return to the Print dialog. 

9. To select laser engraver properties, select the laser engraver driver 
from the list of drivers in the Print dialog and click Properties. 
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 If you want to use color mapping to determine the power and speed 
settings used to engrave your design, select the appropriate option for 
your engraver: 

Epilog Set the Map Colors to Speed/Power print option to Yes. 

GCC Set Mode Setting to Manual Color Fill. 

Xenetech Set Output Mode to Use Color Settings. 

Universal Set Print Mode to Normal. 

 The available properties will vary for each make and model of 
engraver. Please consult your engraver manual for details. 

10. Click OK. 

 
11. If message about adjusting the paper orientation appears, click 

Yes. 

Engraving a Job Using Multiple Passes 
To engrave a job using multiple passes of the laser, select colors for the 
elements of your design that correspond to the cutting speed and power 
needed for a single pass of the laser. Then print the job multiple times 
on the same substrate. Do not move the substrate between passes. 

Printing Multiple Passes of Selected Parts of a Design 
If only certain parts of the design need multiple print passes, you can 
selected only certain parts of a design and then print them as needed. 

To print selected parts of a design: 

1. Select the parts of the design you want to print multiple passes of. 

2. From the File menu, select Print. 

3. In the Print dialog, select Print Selection. 

4. Click OK. 
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Appendix A: Notes on Laser 
Engravers 

GCC, Inc. 
Pen Colors 
Each pen color can be assigned the following settings: 

Speed The speed the cutting laser moves at. A slower-moving laser will make 
a deeper cut than a faster-moving laser, because it spends a longer 
amount of time at each point along the path. 

Power The amount of power supplied to the cutting laser. Increasing the 
power makes the cut deeper. 

Raster Check to output pixels or raster fills that have this color. 

Vector Check to output vector objects that have this color. 
 

Focusing the Laser 
To focus the laser of the surface of the substrate, first lower the level of 
the work area so that the surface of the substrate is below the level of 
the laser cutting head. Move the cutting head over the surface of the 
substrate, then press the Auto Focus button on the engraver. 

Printing and Clearing Jobs 
After a new job is sent to the engraver, you need to press the Next File 
button on the engraver to access the new print job. 

Press the Start/Stop button on the engraver to output the job. 

Once a job has been output, press the Del File button to delete the job 
from the engraver’s memory. 

Xenetech, Inc. 
Pen Colors 
Each pen color can be assigned the following settings: 

Power The amount of power supplied to the cutting laser. Increasing the 
power makes the cut deeper. 

Speed The speed the cutting laser moves at. A slower-moving laser will 
make a deeper cut than a faster-moving laser, because it cuts for a 
longer amount of time at each point along the path. 

PPI The number of laser pulses per inch. 
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Universal Laser Systems, Inc. 
Pen Colors 
Each pen color can be assigned the following settings: 

Determines the types of objects with that color that will be output. 

Rast Only raster fills with this color will be output. 

Vect Only vector outlines with this color will be output. 

Rast/Vect Both raster fills and vector outlines with this color will 
be output. 

Rast 
Vect 
Rast/Vect 
Skip 

Skip No objects with this color will be output. 

% Power The amount of power supplied to the cutting laser. Increasing the 
power makes the cut deeper. 

% Speed The speed the cutting laser moves at. A slower-moving laser will 
make a deeper cut than a faster-moving laser, because it cuts for a 
longer amount of time at each point along the path. 

PPI The number of laser pulses per inch. 
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